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Everything you need to know on how to use the PostProduction Master, the essential Arch Viz post-
production extension for Photoshop. 
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New tab 
The New tab or the New Project tab (Figure 1) is used when working on a new project. It is divided into 
three sections: 

• Input Files 
• Template 
• Output File 

 

Figure 1: PostProduction Master's New tab. 

 

Input Files section 
This section is used to load and stack the render elements into the Photoshop. It has a placeholder 
to show the files that will be loaded during the project creation process. To fill the placeholder we 
have to press the “Browse…” button and then locate and select the files (render elements). During 
the stacking we can choose to split the loaded render elements into two groups: MASKS and 
CHANNELS. MASKS group will contain only the render elements that are used for the masking such 
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as: Wire Color, Render ID, Alpha, MultiMatte, etc. The CHANNELS group includes everything else. 
Both Vray and Corona render elements are supported as the industry standards.) 

 

Template section 
The Template section gives the option to use templates every time when creating a new project, 
allowing us to have a good starting point and to save the valuable time. We can pick from existing 
templates from the list or create a new template using the “New” button. The new template can be 
created from every Photoshop document. The main goal when creating a new template is to leave 
only the stuff that is useful for us and to delete the rest. This will make the file lighter so it will get 
loaded faster into the Photoshop. Because New Project tab works similar to the Update Project tab 
i.e. every render element in the template will be replaced with the new render element (that is 
loaded into the Inputs Files section). This is worth to have in mind when creating a new template 
from the existing project. We can only leave the render elements that are relevant to us and to 
delete the rest to make a file lighter as well as to speed up the project creation process. Only the 
render element left in the template will get replaced. See this video to understand how it works. 

 

Output File section 
In this section we have to specify: 

• The file Name,  
• Convert the image to the 8bit or leave it as it is 
• Choose the location where we want to save the file 

I decided to only use the .psb as the default file type because it is exactly the same as the .psd file 
but without a limitation for the file size of only 2 gigabytes, so it has a plenty of room to work with 
 

  

https://www.youtube.com/watch?v=qSVVyKdPDg8&t=176s
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Update tab 
The Update tab or the Update Project tab (Figure 2) has everything needed to update the render 
elements in a project. It is divided into two sections: 

• New Render Elements 
• Render Region 

 

Figure 2: PostProduction Master’s Update tab. 

 

New Render Elements section 
The New Render Elements is used to load the new Render Elements into the Photoshop. There are some 
options to choose from when loading and stacking render elements: 

• Split into Masks and Channels groups (splits the loaded render elements into two groups based 
on their use. The MASKS group includes the render elements that are mainly used for the 
masking such as: Wire Color, Render ID, Alpha, MultiMatte, etc. While the CHANNELS includes 
everything else. Both Vray and Corona render elements are supported as the industry 
standards.) 
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• Match new render size (matches the image size in pixels (width x height) with the loaded  
render element. Each render element is checked and compared with the Photoshop document 
while loading.) 

• Match new bit depth (matches the image bit depth with the loaded render elements. Each 
render element is checked and compared with the Photoshop document while loading.) 

Updating the project can be divided into four steps: 

1. Before loading the render elements into the Photoshop they have to be loaded into the 
placeholder. This is done by clicking the button “Browse…” and then finding and selecting the 
files (render elements) from the pop-up file browser. 

2. After loading the render elements into the placeholder it is important to press the “Load Files” 
button before the “Update All Render Elements”. By pressing the “Load Files” button all render 
elements that are in the placeholder will get loaded and stacked into the Photoshop using the 
selected options (described above) from the New Render Elements section. During this process 
the extension will show the progress bar animation.  

3. When Photoshop finished loading and stacking the render elements we can press the “Update 
All Render Elements” button. During this process everything is updated automatically and the 
extension will show the progress bar animation. Each render element used in the project is 
replaced with the new one and layer styles (such as blending modes, masks, opacity and fill 
values, and some additional layer styles) are preserved. If we have used the scripts: Invert Layer 
and Remove Transparency the same transformations to the layers will occur i.e. if layer was 
inverted using the Invert Layer script it will be done again, automatically. It is important to 
notice that If the render elements are converted into the smart objects they will not be 
replaced. 

4. After the update has finished there will still remain to fix the layer masks. Because the 
Photoshop doesn’t understand what changed in the 3d layer masks have to be updated if they 
were used. Again, this can be done by using the “Sel to Mask” tool from the Tools tab to speed 
up the process. My personal preference is to have a few layer masks and to use them on layer 
groups as much as possible. Because layer group acts a container for layers everything from the 
group will be affected when replacing only one mask. Look at the following video tutorial to see 
how it can be done: https://youtu.be/svsowSTgnJs 

 

Render Region section 
Render Region section is used only if there is a rendered region. When using this option it is important 
not to update the project using the “Update All Render Elements” because it will mess up everything. 
This option will only load and stack render elements inside the “RENDER_REGION” layer group. 

 

  

https://youtu.be/svsowSTgnJs
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Tools tab 
Photoshop is a tool with a lot of possibilities and I found that after years spent in post-production that 
these tools are essential in my every day workflow. The Tools tab (Figure 3) is divided into four sections: 

• Tests 
• Masking 
• Grids & Guides 
• Misc 

 

Figure 3: PostProduction Master’s Tools tab. 

The sections are aligned by importance. So the most important tools are located at the top but as we go 
down there are still plenty of handy tools. I hope that you will find those tools useful for your workflow 
as they were for me. 
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Tests section 

 

Figure 4: Tests section. 

Test section (Figure 4) is used to easily determine the values of color and therefore make better 
decisions when doing a post-production. As the color can be split into three components: Lightness, Hue 
and Saturation it’s also the case for the Tests section: 

• B/W (Used to check the lightness component of the color. Works as a toggle.) 
• Color (Used to check the hue component of the color. Works as a toggle.) 
• Saturation (Used to check the saturation component of the color. Works as a toggle.) 

When doing a post-production it is necessary to have a lot of photo references (Figure 5) because it will 
save the precious time and improve your workflow. Before using Tests it is the best to move the photo 
references into the same image as the raw render. One good advice is to have the photo references at 
the top of the render. That way it will be much easier to compare the values of the raw render with the 
photo references. The B/W, Color and Saturation tests allows us to separate and observe each individual 
component of the color. Then we can make decisions on what needs to be done to make the image look 
better and appealing to the eye. 

 

Figure 5: Using photo references. 
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As the B/W test is used to observe just the lightness component of the color it is probably the most 
important test. This is the case because the lightness is the foundation of every image. In order to 
achieve photo-realistic results this component needs to be carefully matched. One general rule of 
thumb is that the closest objects to the camera will be darker and have more contrast and the further 
you go the objects should have less contrast and look lighter (Figure 6). 

 

Figure 6: Achieving the depth of the image with light grading. 

As it was mentioned before it is important to observe real photographs as they will give you a good 
sense of what needs to be done but you don’t need to stick to them 100%. You will always have some 
personal preference, maybe you prefer darker images or a of foggy atmosphere and that is ok. As long 
as you observe and compare the raw render to the photograph and see how individual materials 
behaves and looks like and to try to match it with the render I’m sure that you are on the right track to 
make your image look nice. With that in mind look at the images below to see how each individual test 
looks like. 
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Figure 7: B/W test. 

 

Figure 8: Color test. 
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Figure 9: Saturation test. 

It takes some practice to observe the references and to mimic the same effect on the rendered image 
but as you keep working you will get faster and better. At the end you will get the image that looks 
really appealing to the eye.  

 

Figure 10: Adjustment layers. 

Besides various render elements the adjustment layers (Figure 10) are a way to go when adjusting these 
three color components. I use the Curves for the most of the adjustments, especially for the B/W test, 
that is the lightness component. Some other adjustment layers that are useful are Hue/Saturation for 
the color and the saturation component, Color Balance again for the colors, and Selective Color for fine-
tuning individual colors. Also, it is worth to mention that using a various blending modes (Figure 11) of 
these adjustment layers can really fine-tune the end result. 

 

Figure 11: Layer blending modes. 
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The “Luminosity” blending mode is only affecting the lightness component of the color, and the “Color” 
blending mode can be used to only change the color (hue) component. To see that in practice you can 
download the example scene from this link. 

 

Masking section 

 

Figure 12: Masking section. 

The Masking section (Figure 12) has the tools for manipulating layer masks. It consists of: 

• Sel to Group (Creates a layer group that has the layer mask from the active selection and we are 
prompted to write a group name.) 

• Sel to Mask (Creates a layer mask from the active selection or if layer mask is present it replaces 
it with the active selection.) 

• Contract (Contract the layer mask by a specified amount in pixels (1-100px) and blurs it  
if specified.) 

• Expand (Expands the layer mask by a specified amount in pixels (1-100px) and blurs it  
if specified.) 

• Red (Selects only the red channel from the “MultiMatte” render element.) 
• Green (Selects only the green channel from the “MultiMatte” render element.) 
• Blue (Selects only the blue channel from the “MultiMatte” render element.) 
• Alpha (Selects only the whites from the Alpha render element (Figure 13), only if it is saved as a 

file that doesn’t support transparency by default for example .tif file.) 

 

Figure 13: Alpha channel as a render element. 

http://bit.ly/ppm-samplescene
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Grids & Guides section 
 

 

Figure 14: Grids & Guides section. 

The Grids & Guides section (Figure 14) includes the tools for manipulating guides and creating grids. It 
has the following tools: 

• Bounding Guides (Creates bounding guides around the image or if the selection is present it 
creates the bounding guides around that selection (Figure 15).) 

 

Figure 15: Bounding guides created around the selection. 

• Crop by Guides (Crops the image based on the four bounding guides that represent the 
rectangle for the cropping. It is important to have only and exactly four guides for the tool to 
work.) 

• 3x3 grid (Or the rule of thirds as used in Photography, creates the 3x3 grid from guides.) 
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• Golden Ratio Grid (Or sometimes called a Phi grid is also used in Photography and it creates the 
3x3 grid from guides in a golden proportion.) 

• Clear Guides (Deletes all guides.) 
• Show/Hide Guides (Works as a toggle and it hides or shows the guides.) 

 

Misc section 
 

 

Figure 16: Misc section. 

• The Misc section (Figure 16) has the various tools that are also very handy in a post-production 
workflow. It includes: 

• Add Noise (Adds the noise layer that has the blending mode set to “Overlay” and it is useful for 
adding a subtle texture if the material looks too plastic or it can help solve the color banding 
issue (Figure 17). The color banding will mostly appear on 8bit images especially when there are 
lots of adjustment layers stacked on top of each other. The noise layer will sometimes solve or 
reduce the color banding issue as shown on the image below. The noise layer uses the Gaussian 
noise distribution and we can specify the amount in percent (1-100) and it will be automatically 
written into the layer name so it can be repeated later if needed.) 

 
 

 

Figure 17: Example of color banding: 8bit gradient, 8-bit gradient dithered, 24bit gradient. 

 



15 
 

• HighPass (Adds the layer that has the blending mode set to Overlay and uses the HighPass fitler. 
It can be used to increase the sharpness of the selected layer. It works only on the selected layer 
so if you want to increase the sharpness of the entire image (Figure 18) you will have to either 
flatten it or use the “Merge visible” command in Photoshop (the default keyboard shortcut for 
Windows is Alt+Ctrl+Shift+E). Also, we can specify the amount in pixels (1-100) and it will be 
automatically  written into the layer name so it can be repeated later if needed.) 

 

Figure 18: Using the HighPass tool to sharpen the image 

• Snapshot (Merges all visible layers into a single layer and adds it to the top of the layer stack. 
This is something similar as snapshot command in the History panel but with a difference that it 
remains even after the Photoshop is closed and opened later which is not the case with the 
History panel. The snapshot layer name starts with the “SNAP” and it has the date that shows 
when this snapshot was created. I found the snapshot layer very handy when updating the 
project and something unpredictable happened in the 3d. You can easily return what got 
“messed” up in the 3d just by revealing the snapshot layer using the layer mask.) 

• Camera Raw Layer (Works similar as the Snapshot tool but with a difference that it creates the 
smart object layer and names it “CAMERA_RAW”. This layer can be used for the Camera Raw 
filter or any other filter. Because it’s a smart object it stores the used filters as smart filter. This 
way it’s easy to repeat exactly the same settings used on a filter. My personal workflow is to use 
this Camera Raw filter at the top of layer stack and there make the final adjustments to the 
image.) 

• Clean PSD (Makes the Photoshop file a lot cleaner. It deletes all empty layers, capitalizes layer 
group names, deletes color test layers and adds numbers to the duplicates of the group names. 
Clean PSD can be adjusted to our preference inside the Settings tab.) 

• Export Selected Layer(s) (Exports the selected layer(s) as separate files. This tool can be adjusted 
to our preference as well inside the Settings tab. We can specify the file format: jpeg, png, psd 
or tiff and to put the exported files into a subfolder. The tool works on regular layers as well as 
on layer groups, or the combination of both.) 
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• Save Image (Saves the image to the specified file format. When using this we will be prompted 
to specify the Resolution, DPI, Chromatic Aberration, High Pass, Crop by Guides, Watermark and 
the output file. The Resolution includes: Original resolution (nothing will be changed) all 
international print file sizes from A, B and C, full HD, 4k or 8k. If the selected resolution is 
different from the current resolution the image will be resized by the longer edge to the 
specified resolution. The DPI can be specified as well and it includes the: 72, 96, 150, 300, 600, 
720, 1200, 1440, 2400, 2880. Chromatic Aberration adds a subtle chromatic aberration to the 
image which simulates the real camera lens effect. High Pass adds 1px high pass filter to the 
image which sharpens it a little bit. Crop by Guides crops the image by the specified guides. This 
will only work if there are exactly 4 guides, 2 horizontal and 2 vertical guides. Watermark adds a 
subtle watermark to the image which includes the copyright symbol and the current year. And 
finally, the output file gives us to choose from three file types: JPEG, TIFF and JPEG e-mail (which 
is the very compressed version of the image suitable for regular e-mails). Also, one more thing 
to mention is that when saving an image using this tool automatically tries to solve the color 
banding issue by converting the image into a 16bit color space and then applying some filters to 
remove it. The JPEG file is saved using a maximum quality (12) to ensure the best possible 
quality of the image and the TIFF file is saved as a flat file (all layers are flattened) and in a 16bit 
color space. After saving is done it will automatically remember the specified settings and when 
opened again the same settings that were used the last time will be active again. The last used 
settings are stored always, even if the Photoshop is restarted.) 

 

Figure 19: Final image saved using the Save Image tool. 
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Settings tab 
In the Settings tab (Figure 20) we can set the default behavior of the two tools from the Tools tab. The 
tools that can be configured are: 

• Clean PSD 
• Export Selected Layer(s) 

 

Figure 20: PostProduction Master's Settings tab. 

Clean PSD can be adjusted to: 

• Delete all empty layers 
• CAPITALIZE group names 
• Delete color test layers (This includes: B/W test, Color test, Saturation test.) 
• Add numbers to duplicates (Only looks for duplicates in the layer group names, regular layers as 

well as all other layer types are ignored.) 

In the Export Selected Layer(s) we can configure how we want to save our selected layers. We can pick 
the image format: jpeg, png, psd, tiff and to put the exported layers into a subfolder. 
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Help tab 
Besides this written guide there are some short video tutorials available on Youtube. The Help tab 
(Figure 21) also has this links so you can access them directly from the extension. 

 

Figure 21: PostProduction Master's Help tab. 

For the convenience I left the links for the video tutorials below: 

• How to create new project: https://youtu.be/qSVVyKdPDg8 
• How to update project: https://youtu.be/svsowSTgnJs 
• How to use tools: https://youtu.be/yc0QV3YvGL0 
• How to set keyboard shortcuts for Tools: https://youtu.be/0M4Av3pW7Ks 

https://youtu.be/qSVVyKdPDg8
https://youtu.be/svsowSTgnJs
https://youtu.be/yc0QV3YvGL0
https://youtu.be/0M4Av3pW7Ks
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